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Getting Started

Beqginning Electronic Filing

Electronic filing is:
1. Required when a political committee or other person receives contributions or makes
expenditures in excess of $50,000 in the current calendar year or has reason to expect to do so.

2. Voluntary for any political committee or other person that receives contributions or makes
expenditures less than $50,000 in the current calendar year. However, once a committee decides
to e-file on a voluntary basis, it must continue to do so for the remainder of the calendar year,
unless the Commission determines that extraordinary and unforeseeable circumstances have
made it impractical for the political committee or other person to continue filing electronically.

3.

Requesting a password:
1. The request must come from the official committee treasurer or assistant treasurer. It is
recommended that the assistant treasurer obtain a separate password.

2. Requests must be faxed to 202-219-0674 or mailed to:

Electronic Filing Office
Federal Election Commission
999 E Street N.W.
Washington, DC 20463

3. The password request letter should utilize committee letterhead and include:

~® o0 oW

The committee name

9 digit FEC ID number

Treasurer’s name

Phone number

Treasurer’s signature

If the assistant treasurer would like a separate password, then that person’s information
must also be provided and both the treasurer and the assistant treasurer must sign the
Password Request Letter.

The following statement must be included in the request for a password: ““I represent
that | am the duly appointed treasurer and have that authority to sign FEC reports for the
above named committee.”

4. Upon verification by the Electronic Filing Office (typically within a few hours) the password
will be provided via telephone.

5. Note: if a password is lost, the committee must request a new password by following the same
steps outlined above.

FECFile Training Manual
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Downloading Software:

1.

o A~ WD

© © N o

Note:

From www.FEC.gov, click the e-Filing link at the bottom of the page.

Links Inspector General

20463 (800) 424 9530 In Washington (202) =

mssmmamPianes shass e ehis sita oo tha sivak v cn s

Click FECFile Filing Software.
Confirm Minimum System Requirements are met.
Click Download FECFile Now.

Click Download Now at the top of the screen for the most recent version of FECFile.

FECFile Update List

Download Now
Build X. X . X.X.

Enter the committee’s information and choose Submit.
Enter additional information (for new committees only).
Click the FECFile X.X.X.X link to download FECFile.
Follow your computer’s download instructions.

. Double-click the FECFile install icon and follow the installation prompts.

Manual
Candidate

FECFile will automatically check for the latest program updates every time you start the

software.

FECFile Training Manual
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Creating a New Committee File

1. Start FECFile using either the desktop icon or the computer’s Start Menu.

2. Click Create a new committee file. Use this file every time a report is created.

3. A window will appear to confirm the creation of a new committee file. Click OK.

Open a Committee File L x|

& Creste a new Committee File
€ Qpen an existing Committes Fle

Fa

F4
FS
FS5
F?
F9
F9

an Committee [Non-Presidentiall

- Joint Fundraising Committee [&uthorized)

F3X - Joint Fundraising Committee (Unauthorized)

F3X - Political Action Committee

F3X - Political Party Organization

F3X - Other (Political) Committee

- Committee/0Organization supporting convention

- Independent Expenditure Filer - Individual [Non-political/Non-profit)

- Independent Expenditure Filer - Organization [Non-political/Non-profit)

- Communication costs Filer

- Electioneering Communications Filer - [Non-political/Non-profit) Individual
- Electioneering Communications Filer - [Non-political/Non-profit) Organization

FECFile Training Manual
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5. Enter the committee’s ID number, name, and address. In the
“Authorizing Candidate” field at the bottom of the page, type
the candidate’s name (last name, first name) and press Tab.

a. A new window will open. Enter the candidate’s
information and click OK. The “Campaign Committee
— FILER” window will reappear.

b. Enter the candidate’s information at the bottom of the
window. When finished, click OK.

6. Click Yes at the prompt.

Fece X

! E Would you like to create a Report and enter your Report Information now?

| Yes I No I

7. Click OK at the prompt.

x

! ': First, please enter the Election Cycle for this report.

Manual
Candidate

Campaign Committee - FILER

Ivpe ™ tatins! T Mubti-Candidatel

I Campaign Committes
Committes | [eg. C12345678)
Lookup...
- If Committes/Organization
Name

My Committes

8. Enter the current election cycle. An election cycle begins the day after the previous general
election for that office and ends on the date of the next general election. For House candidates
this is 2 years, for Presidential this is 4 years, and for Senate candidates this is 6 years.

x|
Date From
_DK
0
Date Thiu —l

Enter 207 of the averall expenditure limit as published by the FEC

—

FECFile Training Manual
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Creating the First Report (Form 3) in a New Committee File
1. Select the Type of Report from the Report’s drop down
menu and, if necessary, modify the “Date From” and “Date Report information x|
Thru” fields.
. Miw.. S Gatery -
2. Select the election cycle. Desbon DeeDw Ejeckondue B
3. To sign the report, click in the Signed by box. Enter the [ BN
treasurer’s name (last name, first name). If the treasurer has ik L :”s_f't =
not already been entered into FECFile, press Tab or Enter. @ '
a. An “Individual/Organization” box will appear. =
Ensure that the type selected is “Individual other Smith, Joe - 536 Elm Stieet
than a Candidate” and enter the rest of the
treasurer’s information (name, address, etc.). o TER PR Clcose e ot sdee
b. After entering the treasurer’s information, click OK
to return to the Report Information box. S e S
4. After all the information is entered, click OK. ) =0

5. A window will appear, with options for what to do next in

the report. To view the Summary Page and begin to ad
transactions click OK. To view the
Individuals/Organizations screen, click Cancel.

Fecie x|

1 You may proceed to add transactions to the current report OR you may choose to add Individuals/Organizations to your file, Would you like to add
. transactions to the current report now?

oK Concel |

FECFile Training Manual
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1. Inthe *“View” menu, click Reports.
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Creating a New Report in an Existing Committee File

Manual
Candidate
Select the report type | X|

2. In the “Edit” menu, click New, or right click anywhere

in the Reports window and click New.

3. Select the report type you would like to create (Forms

3,6,3L,1,1M, 99, or 2) and click OK.

1. Create a Statement of Organization by
following the steps on the prior page to
create a new report and choose Form 1
(Statement of Organization). Click OK.

2. The *“Statement of Organization” dialog
box appears. Select the type of committee,
and enter the party code, website address
(if applicable), fax number (if applicable),
e-mail address (required), and date.

3. If the “Treasurer” field does not already
contain the name of the committee’s
treasurer, click Edit.

a. Select the treasurer’s name from the
scroll box. (Note: if the treasurer’s
name does not appear in this box,
press Tab or Enter to input that
individual’s information.)

b. Enter the Treasurer’s phone number
and Title/Relationship to the
committee, then click OK.

4. To enter connected organizations, affiliated
committees, leadership PAC sponsors, joint
fundraising  representatives; designated
agents; and banks/other depositories, click
on Agents...

Report of Receipts and Disbursements [Form F3)
48 hour notice [Form B)

Form 3L - Report of Bundled Contributions

Form 1 [Statement of Organization)

Form 1M [Notification of Multicandidate Status)
Miscellaneous Electronic Submission [Form 99)
Form 2 (Statement of Candidacy)

Creating a Statement of Organization (Form 1)

| 0K I Cancel
x
— Type of Committee
. Paity code
® Principal Candidate Committeel ﬁ|
O Authorized Committee (Not Principal) [

O Supports/Opposes only one Candidate (unauthorized)

O Separate Segregated Fund
€ Comporation

O Not S5F or Paity, suppoits/opposes more than one candidate

[ Lobbyist/Hegistrant PAC ] Leadership PAC
(o] Party Committee
& National  State € Subordinate
© Joint Fundraising Representative [Autharized: g)
Committees Participating in

O Joint Fundraising Representative (Unauthorized: h) Joint Fundraiser...
Custodian of Records
I Edit
Treasurer
[7 Edt |  Agents.
Website Address [URL)
[ [ URL has changed
Date e:mail
[ =~ [ E-mail has changed
Signed by
| O Committee name

has changed
Addiess has
o changed
oK | Cancel |
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a. The “Affiliations, Agents & Banks Related to the Committee” dialog box will appear.

Affiliations, Agents & Banks Related to the Committee _u

Name | Type | Title/Position :

< |

b. To add a connected organization, affiliated committee, leadership PAC sponsor, or joint
fundraising representative, click on Affiliation...

Affiliations, Agents & Banks Related to the Committee i |

.Name

m Edt.. |

" Connected Drganization
" Affiiated Committee 0K |
" Leadership PAC Sponsor Cancel |

@) Joint Fundraising Representative
| 0K I Cancel
4| |3

FECFile Training Manual
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c. Select the name of the connected organization, affiliated committee, leadership PAC
sponsor, or joint fundraising representative from the list. (Note: if the name of the entity
does not appear, and press Tab or Enter to input its information.)

d. Under “Relationship Type”, select the corresponding type of relationship then click OK.
To add a designated agent (for example, an assistant treasurer), click on Designated...

a. Select the name of the designated agent from the list. (Note: if the individual does not
appear, type the name (last, first), and press Tab or Enter to input that individual’s
information.)

b. Enter the designated agent’s phone number and title/position with the committee, then
click OK.

To enter a bank/other depository, click Bank...

x|

Name I Type | Title/Position ~Addnew

Banks/Other Depositories x| Affiliation....
Designated....

Name —————
!

L ]

Edi....

Phone Title/Position &l
| | 0K |
| oK I Cancel Cancel |

e Select the name of the bank/other depository from the drop down box. (Note: if the
bank or depository does not appear, type the name (last, first), and press Tab or Enter
to input its information.) Click OK.

To edit an entry in the “Affiliations, Agents & Banks Related to the Committee” screen, click on
the particular entry to highlight it, then click Edit.

To delete an entry in the “Affiliation, Agents and Banks Related to the Committee” screen, click
on the particular entry to highlight it, then click Delete.

After entering the information, click OK.
Click OK after returning to the “Statement of Organization” box.

FECFile Training Manual
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11. The Form 1 is now created. To view the Form 1 to ensure that it is complete, click the printer
icon in the top menu bar in order to see the committee’s information as it looks filled in on the
FEC forms.

NH)® 257008855050

FECFile Training Manual
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FECFile Basics

Saving in FECFile:

FECFile creates a committee database (with file extension .DCf), which holds the entirety of the
committee’s reporting history. This includes all reports, amendments, and contributors or vendors with
whom the committee works.

1. Save the file as often as possible. This will decrease the chance of massive data loss. Be sure to
save the file in a location easily accessible and easily remembered. Additionally, it is also
recommended that you back up the file to an external source, such as a flash drive, external hard
drive, or CD.

2. For each new report, open the same committee file. Do not create a new committee file each
time the committee files a report. This will lead to problems with election cycle-to-date
amounts, cash on-hand amounts, and aggregate amounts.

Using the Different Views:

FECFile is organized into seven different views or windows: Reports; Summary Page;
Individuals/Organizations and Events; Receipts; Disbursements; Loans, Debts, & Other Obligations; and
All Transactions. Each of these views displays a different aspect of reporting and is used to create and
modify both reports and transactions. There are three different ways to access a view:

1. When FECFile first opens, tabs will be displayed underneath the icon bar. Click on the tab to
access the desired view. Tabs can be rearranged by dragging them to another location on the tab
bar.

f& FECfile - Manual Committee.DCF

File Edit Wiew Window Help

&pril 15 Quarter )9 - 03/31 /2009 01272010 Davis, Sam 11/05/2008 - 11 0.00 0.00

July 15 Quarter 9 - 06{30/2009 Davis, Sam 11/0S/2008 - 11 0.00 0.00

F3L - July Month)9 - 0&/30/2009 = 11/05/2008 - 11

October 15 Que)9 - 05/30/2009 12/07/2009 Davis, 5am 11/05/2008 - 11 0.00 29441.71
48-hour natice { - 10/01/2009 Davis, 5am  11/05/2008 - 11

A1:50:4prl 15 (10 - 03/31]2010 04/16/2010 Davis, S5am 11/0S/2008 - 11 29441.71 154441.71
July 15 Quarker 10 - DEF30/2010 Jones, James  11/05/2008 - 11 154441.71  161441.71
B2y, - S 11f0sfz008-11

48-hour notice ( - b4fz0f2010 Davis, 5am 11f05{2008 - 11

FECFile Training Manual
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Horizontal Tab or Open in New Vertical Group.

[B FECfile - Manual Committee.DCF

Manual
Candidate

In order to view two tabs side-by-side, right-click on a tab and select Open in a

Bile Edit View Window Help

IWH|=E 25 .

(] 388 &

— 3
. @
-

" Individuals/Organizations and Events - i’ Reports ] Receipts r Dlsbm'ernms/" v mﬂmm\mvl

Line# | Name |

Date

|__Balance |

Tota | L P.]

Open in New Horizontal Group

QOpen in New Vertical Group

Cancel

[l FeChibe - Manual CommitteeDEF

Bl (ot Yew Wndow Hep

Hlwl@ 23] 08855000

[m [j|'$@ = | 1| »"& - &3 -

" inamiduats rganizations and Events - | Reports | Disbursements. x| Loans and other OBligations | || Receints x|

nes | Name | Dats | Amouwk | Apgregate | L[ P! | [unes | name [ oste | amouk | Aggegste | L. P..

1y dohe's Hardware OT28/2005 74.63 7463128 11(s)  Smith, X 08[22[2009  4B00.00  4800.00118

17 Jnes, James OO10/2009 45645 45645117 [MI11(s) Smith, Joe 032202009 240000 4600.00120118

20(s)  Jobreon, dosaph 072202009 150000 1S00.0013 13(a)fa  Smith, Xa 08242009 2500000 25800.0013

17 US Postmaster 142009 106.24 106,24 132 11(a)  Davis, Sam O9/1Sf08 200000 2000.00109

17 Credk Card Company GE/42009 247742 24774213 [M]11(a) Sah, Jane 03fz202009  2400.00 0.00121 118
1ia)  Jones, James 009 45645 45645116
11{a)  Johnson, Joseph 071272009 1600.00 1800.00 130

b. Tabs can be closed by clicking on the “X.” New tabs can be opened or re-opened by
using the “View” menu or clicking on the appropriate icon (see next page for FECFile

ey Ve

Views).
2. Under the “View” menu, select the desired view:
File Edit | view Window Help
m 1 Individuals{Organizations
" | Election Cydes
7 Indy  Ceports
all Transactions
| Type
April 15 qu  2ummary Page
July 15Qu  Receipts
F3L-July |  Disbursements
October 15 Loans and other Obligations
48-hour nc
AL:S0:Apr - Recycle bin
lel‘ll5QU Sort. .. Chrl+r
a6 hour e oeardh... Curl+F
3.

Click on the icon, located across the top of the screen, representing the view:

U

FECFile Training Manual
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About Each FECFile View:

T

—_—
B

v
-

¢

U

Reports View — This view lists all reports created in the committee file. Transactions on these
reports can be modified if the report is “open” (see page 27). Reports also can be amended
using this view by right-clicking on the report and selecting Amend.

Summary Page View — This view shows both itemized and unitemized totals for each line
number in both the period covered and the election cycle. Transactions may be entered on line
numbers by double clicking a line.

Individuals/Organizations and Events View — This view lists all entities entered into the
committee database, including the committee’s information, contributors, other political
committees, businesses, etc. Modify an entity by double clicking on it.

Receipts View — This view lists all receipts entered in the report currently selected in Reports
View. Modify a transaction by double clicking it, or right click an entry for a list of options
such as creating a new transaction, deleting a transaction, adding memo text, etc.

Disbursements View — This view lists all disbursements entered in the report currently selected
in Reports View. Modify a transaction by double clicking it, or right click an entry for a list of
options such as creating a new transaction, deleting a transaction, adding memo text, etc.

Loans, Debts, & Other Obligations View — This view lists all debts, loans, or other obligations
that are owed to or by the committee in the report currently selected in Reports View. Modify a
transaction by double clicking it, or right click an entry for a list of options such as creating a
new transaction, deleting a transaction, adding memo text, etc.

All Transactions View — This view lists all transactions entered in the committee file.
Transactions are sorted by line number and name.

Memo Text:

Memo text is used to provide additional information regarding reports and transactions. Memo text can
be added by highlighting the report or transaction, right-clicking, and choosing Memo Text... from the
available options.

Working with Contributors and Vendors:

FECFile creates a database for all entities (individuals, businesses, PACs, Political Party Organizations,
etc.) within the committee file. This saves the committee from repeatedly entering the contributor or
vendor information if a committee conducts multiple transactions with a particular entity.

There are two ways to create an entity:

1. When entering the first transaction associated with an entity, make sure the cursor is in the
“Name” field and press Tab or Enter. The “Individual/Organization Information” window
will appear.

2. Using the Individuals/Organizations view, right click anywhere in the workspace and click
New from the available options. The “Invididual/Organization Information” window will
appear.

FECFile Training Manual
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Filling Out the Individual/Organization Information Box

1. Select the correct entity type from the drop down menu at the top of the window.
e Note: FECFile disables any field that is not required for a type of entity.
2. After entering the information, click OK.

Using the FEC “Lookup” Feature:
Click Lookup...

Individual /Organization Information

to access the FEC’s database of federally registered
candidates and political committees. Use the feature to save time
when entering information for a federal candidate or political

Type I~ National

Campaign Committee

Committee ID (eq. C12345628

committee. N
1. In the “Individual/Organization Information” box, click r f Committee/Drganization .
Lookup...
2. The “FEC ID Lookup”
window appears.  Scroll FECIDlookup ] lél
H H Committee/Candidate Name I Ca.. I Ca | Co... I Eo | Committee... | Other ID -
through the IISt and CIICk FRIENDS OF GUY PARISI H H C00288498 H4NY19032
once on the entry to FRIENDS OF HANK SANDERS H AL H AL CO0257683  H24L07025
. . . FRIENDS OF HEIDI FOR CONGRESS H Wh  H Wa  C00335145 H3wADS043
highlight it. FRIENDS OF HENRY F WOJTASZEK H NY H NY (00330083 H2NY28102
FRIENDS OF HERMAN CLARK FOR CONGRESS H GA H GA  CO0257162 H2GADB032
i FRIENDS OF HIGHER EDUCATION INC 2] DC 00032445?
3' Copy ) a“ appllcable FRIENDS OF HILLARY S NY S SONYD0188 -
information by clicking FRIENDS OF HOLLENBECK FOR CONGRESS HoOM R M CO031378  HoMIo4074
FRIENDS OF HOUSEMAN FOR CONGRESS H IN H IN C00308445 HEIND4034
COpy A“ FRIENDS OF HOWARD MILLS 5 NY S NY  CO0397331 S4NY00156
FRIENDS OF HOWELL HEFLIN COMMITTEE 5 AL S AL C0O0DD85951  SAALODO0OSO
1 1 FRIENDS OF HUNTER SMITH FOR CONGRESS H CO H CO  CO0335786 HSCOO1048
4' UnCheCklng boxes in the FRIENDS OF ISAKSON 5 Ga S Ga  CO0392340 SEGAO0D11S
window that appears will FRIENDS OF ISRAEL 1 NY  CO0265470
. . FRIENDS OF ISRAEL POLITICAL ACTION COMMITT... Q Ca  COM41747
exclude that information FRIENDS OF JACK KINGSTON H GA H GA COO261958 H2GAO11S7
- H FRIENDS OF JACK MACHEK H P& H P&  CO0352260 HOPAD4204
from copying to the entity | ¢renps of sacx orcauLL s CT S CT Coossdsse SCTOl45 |
record. Cllgk OK and all Pev | Nex
of the committee’s checked
information will be copied
into the entity record. ]
Name: [¥ [FRIENDS OF HILLARY
5. Click OK to return to the transaction screen. e
Address 2: V|
City: ¥ | [WASHINGTON
State: [v |DII Zp: ¥ |2
Candidate infarmation
’7 Office: ¥ |5 State: [V |r-r.' Distiict : [V IF
[ ok ]| cocel |

FECFile Training Manual
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Receipts

Receipt Basics

1. Click the “Summary View” icon at the top of FECFile. In the “Summary Page” window, double
click on appropriate Line to enter a transaction.

8 Summary Page - Form 3 B

Line# | Description | ThisP.I | ThisP.U CTD.I | CcTD.U h
11(a Individual Contributions S5600.00 5600.00
Contributions from political party committees 15000.00 15000.00
11(c) Contributions from other political committees 10000.00 10000.00
11(d) Contributions from the candidate
12 Transfers from other authorized committees

13{a) Loans received from the candidate

13(b) Other loans received

14 Offsets to operating expenditures (refunds, rebates, etc 1400.00 33.45 1400.00 33.45
15 Other Receipts (Dividends, Interest, etc.) 2045.00 187.68 2045.00 187.68

2. Click on the name in the list scroll box immediately beneath the name field if the entity already
exists in the committee’s FECFile database. If the entity is not in the database, press Tab or
Enter to add the information. Refer to page 6 for more information.

3. Enter date and amount and any applicable description of the transaction (“partnership”, for
example).

4. Enter the election and year of election for the contribution.
Click OK.

FECFile Training Manual
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Special Categories of Receipts
In-Kind Contributions
When entering an in-kind contribution, click the “In-Kind” box x|
shown at right and add a description. Note: Checking the “In-Kind” Nome
box will automatically create the necessary balancing entry on Hiohnson. Joseph
Schedule B. Use the “Description” field to add a description of the T
|n_k|nd reCElVed_ Jones, James - 2217 Osk Tree Cout .:.l
Date Amount
|1722mm | m@
Degerghon
Jirvkind - Food for hundrasses
Ejecion You ol Elechon [~ Memo
{Presaey =Jj2m0 .
Canddate/Campan Commitee

Reattribution/Redesignation of a Contribution
Go to the “Receipts” view.

1. Find the contribution to be EEEES
reattributed or redesignated and right

. . (a) |Smith, Joe 4800.00| 4500.00)116
click on it Mouse over the [ii() Davis, 5am m Ins 2000.00  2000.00 109
“Redesignate/ Reattribute.” Then |!(® e e o i mel sl
click Reattribute or Redesignate in Clore...
the box that appears. Transaction Spik..

LognfDebt payments, .,
Reattribute

2. After ChOOSIﬂg Reattribute or

Redesignate, enter the correcting information =
for the transaction and click OK. Note: Name

Remember to cross reference by including the {Smith, Joe

name of the original contributor in the Smith, Jane - 536 Elm Street. .. -
description field. Click OK to return to the Sméth, Joe - 536 Elm Street... E’

“Receipts” view.
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a. For reattribution, highlight the newly created negative entry that FECFile generated for the
original contributor, then right click and click Modify...

I

11{a) Sroith, Joe
[M]11(a) Smith, Joe
11(a Davis, Sam
11{a) Jones, James

08/22/2009 4300.00 4800.00 118
08f22{2009 -2400.00 4800.00 120 118
09/15§2009 2000.00 2000.00 109
09/10/2009 456,45 New...

b. Update the description field to include the name of the person to whom the contribution is

being reattributed.

3. Click “OK” and then click “Yes” at the prompt.

48-Hour Notices (Form 6)

1. A 48-hour notice is a separate filing from a

Form 3.

2. To prepare to create 48-hour notices, first create
the Form 3 that includes the 48-hour notice

period.

3. To create a 48-hour notice, go to the “Reports”
view, right click, and click New. Click “48-hour

notice (Form 6)” and click OK.

4. The “48-hour notice (Form 6)” box will appear;
fill in the election date, the state, and enter the
treasurer’s information in the “Signed by” box.

All fields are required.

x|
c—— CF@ .

None b
=

Dawis, Sam - 746 White Oak Street
Johnson, Joseph - 3837 Weeping Willow Drrve
Jones, James - 3217 Dak Tree Court

[ ]

Lol

Cancel |

Click OK. Note that at this point the notice is not complete.

Select the “Reports” view and select the 48-hour notice by clicking on it.

7. Select the “All Transactions” view and locate the receipt(s) that needs to appear on the 48-hour
notice. Receipts will be sorted by line number and then alphabetical order.

8. After finding a transaction, select the entry, right click, and click Add to Form 6. (See next page
for example.) Repeat this step until all the required contributions have been added to the 48-hour

notice.

FECFile Training Manual
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1 All Transactions _.lnlll
11(3)  Jones, James = [V Ins 456,45
11(a)  Smith, Joe Modfy... Cerlbm 4800.00
17 Jones, James Delete Del 456.45
e S 2.0
[M]11(a) Senith, Joe 2400.00

Transaction Spit. .

Loan/Debt paymerts..,

Memo Text...

Redesignate/Reattribute. . »

Forgive/oettie, .,

Close Report.,

Amerd. ..

The 48-hour notice is complete. Close and upload it in the same manner as a regular report of receipts

and disbursements (see page 27).
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Bundled Contributions
1. Select the “Reports” view and create a Form 3L x|
(Report of Bundled Contributions). Select the Type of Report
correct report under “Type of Report,” and input [October 15 Quattery ~|
the treasurer’s name in the “Signed by” box. Date From Date Thru Election date
77172009 |9/30/2009 |
State District Semi-annual Period
|None = € Jan |- Jun 30
€1 July 1 -Dec 31

r This report discloses a new
committee address & None

-
-

Jones, James - 3217 Dak Tree Court...

| oK I Cancel

2. Once the Form 3L is created, contributions can be

add_ed to iF by che_ckir]g the “F3L Bundle” box o _ %
while entering contributions to the Form 3.
Nome
3. To specify the bundler, select the [chrson, Joseph
Lobbyist/Registrant  from  the  scroll  box Johe's Hardware - 943 Dogwood Lane. a
underneath. If the Lobbyist/Registrant does not Johnson, Joseph - 3337 Weepng Wilow Diive...  —
. . . Jones, James - 3217 Oak Tree Court
appear, type the name in the “Lobbyist/Registrant .

Bundler” box and hit Enter or Tab, and then input [z | 56000 I Inkind
the necessary information.

—
4. The Lobbyist/Registrant will only appear on the [
Form 3L if the total activity attributed to them Election Yo of Election [~ Memo
exceeds the itemization threshold during the [Premacy ~Jf2010 o
coverage dates of the Form 3L. Candidate/Campaion Commites

5. Close and upload the Form 3L in the same manner |
Joe Smth for Congress - 1855 Maple Averue. ..

as a regular report of receipts and disbursements Computers PAC - 643 Magnoka Tral. ..
(see page 27). Smih, Joe - 535 Elm Stiee...

Category code

|
Check No. Acgount Identier

Ngat enty... | 0K
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Tips for Reporting Receipts

1. FECFile automatically itemizes contributions according to the thresholds outlined in the law. By
entering a record for each individual who contributes to the committee, regardless of the
contribution amount, FECFile can track aggregate election cycle-to-date totals more effectively,
and, if a contributor crosses the $200 threshold, itemize that individual.

2. To report an offset to operating expenditures, please include additional text in the “Description”
field indicating “Refund,” “Rebate,” etc., as well as the original date of the corresponding
disbursement.

3. The check number and account identifier are NOT required fields and do not show up on a
report. However, providing this information will allow the committee to keep better internal
financial records.

4. The “Aggregate” box should remain checked so that transactions aggregate on an election cycle-
to-date basis.

5. Memo entries can be used for any transaction requiring supporting information, and when the
amounts should not be included in cash on hand totals.

FECFile Training Manual
Page 20



Electronic Filing: Hands on Training with FECFile
Manual
Tab 6

Disbursements

Disbursement Basics
1. Go to the “Summary Page” view and double-click on the appropriate line.

17 Operating expenditures 10510.34 10510.34
18 Transfers to other authorized committees

19{a) Loan repayments made to the candidate

19(b)  Other loan repayments made

20(a) Refunds of individual contributions 1000,00 1000.00

20(b) Refunds of contributions from political party committees S000.00 S000.00

20(c) Refunds of contributions from other political committees 15.00 15.00

21 Other disbursements 15000.00 54.12 15000.00 54.12
21 Loans made

2. A disbursement box for that line number will

appear. x

3. Select the payee’s name from the scroll box below @
the “Name” field. If the entity is not in the |

database, press Tab or Enter to add the information. Jcm‘::g&%?;ﬁurﬁ e EI
L Davis, Sam - 746 White Dak Street L’
4. Complete the date, amount, description, and all (pe ) (amours)
other applicable fields. 000 I Infind
5. Click OK. @
Election Yex ol Electhon [~ Memo
I =l

Special Categories of Disbursements

Reimbursements and Credit Card & Payroll Payments:

Payments to credit card companies, payroll companies, and reimbursements all need to list supporting
memo entries to disclose the ultimate recipient of the funds.

1. Double-click the desired line of the Summary Page and enter the entity receiving the
reimbursement or payment. In the description field, provide an acceptable description, such as
“Reimbursement,” “Payroll payment,” or “Credit card payment.”

2. Go to the “Disbursements” view and find the transaction that needs supporting memo entries.

FECFile Training Manual
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3. Right click on the transaction and click Transaction Split.

[B pisbursements

 Line# | Name | Date | Amount | Aggregate | L. P.|

20(a) Johnson, Joseph 07f22[2009 1500.00 1500.00 131
John's Hardware 07 3 74.63 74.63 128

Credk Card Company - — 77421134

17u US Postmaster

17 Jones, James

2477 42134
106.24 132
456.45 117

4. Click Add new....

A new transaction window will open. Fill out the original vendor’s information and click OK
when finished. (Note: the “Memo” box is grayed out as the transaction will automatically appear
as a memo entry.)

fransactionsphts
| Name | Amow | Date
Xl

Oprer otang Expenditure 1

Noare
[.‘dn's Hydaue

Dava, Sam - 746 White Disk Steat -
Jobn's Handware - 343 Dogwood Lane
Jobrwon, Josech - 3537 Weepr Wilow Dive =

Dae Amourt
« je2un | 473 I ks
Descrphon

[Mow cffice locks

6. Repeat this process until all of the supporting memo entries for the payment or reimbursement
have been entered.

7. After entering all of the supporting memo entries, click Close to return to the “Disbursements”
view.
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Debts and Loans

Schedule D: Debts

Debts Owed by the Committee:
1. Select the “Summary Page” view.
2. To add a new debt owed by the committee, double click on Line 10 (Other Debts Owed BY the

Committee).
f_|_: Summary Page - Form 3 =101
| Description | TPl | ThePu | CTDI | CTDU |
Individual Contributions 056,45 056,45
11(b) Cortributions from poltical party committees
11(c) Contributions from other political committees
11(d) Cortributions from the candidate
12 Transfers from other sutherized comenittees
13(a) Loans recetved from the candidate
13(b) Other loans received
14 Offsats to operating expendtures (refunds, rebates, etc
15 Other R: Devidends, Interest, etc.
e e ]
17 Operating expendiures 293
18 Transfers to other authorized committees Name
19(a) Loan repayments made to the candidate
19(b)  Other loan repayments made
20(s)  Refunds of indvidusl contributions 150 | Joe Smith for Congress - 1865 Maple Averue. il
20(b)  Refunds of contributions From political party committess Computess PAC - 649 Magroka Trad -
20(c)  Refunds of contributions from other political committess Credit Card Company « 34836 Cherrywood Stieet ..J
21 Cther disbursements Amount I Settied
21 Loans made Dele 2 Roe
| I 000 |
23 Cazh on hand Degerpton
9 Loans owed TO the committes I
9 Other dabts owed TO the committes Election leckon
10 Loans owed BY the committes L
Candidate
Joe Smith for Congrest - 1865 Maple Averue. .. ﬂ
Computers PAC - 549 Magnoba Trad ..
S, Joe - 536 Elm Shreet . =
Notey. | [ ok ] Concel |

3. Select the name field and enter in the debtor. If the vendor has not been added to the system,
press Tab or Enter.

4. Enter the date, amount, and the purpose of the debt in the appropriate fields.
Click OK.
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1. To add debt repayments, go to the “Loans/Debts” view.
2. Right click on the debt to which you would like to make a payment and click Loan/Debt

payments.

13 Bank Certer First
10

02/ 28/ 2004

Memo T3t
Redesgnate/Reattribute. .,
Forgive/Settle. ..

Sort...
Itemization

137500.00
3000 (0

Crker

In the “Loans/Debt payments” box, click on Add new....

4. In the “Select the type of Deferred Disbursement” window, click on the line number the payment

will go on, such as Operating Expenditure [17].

5. Enter the name of the vendor, date, amount, and the purpose of disbursement.
6. Click OK. The debt payment should now appear in the “Loan/Debt payment” dialog box.

7. Click Close.
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Schedule C & Schedule C-1: Loans

Loans Received:

1.

Go to the “Summary Page” view and double click on
Line 13(a): Loans received from the candidate or 13(b):
Other Loans Received.

Type the name of the creditor in the “Name” field. If
the creditor has not been entered into the system
previously, type the name and then press Tab or Enter.

Enter the date the loan was incurred, amount of loan,
interest rate, election type, year of election, and the
loan’s due date.

If the loan was secured, check the “Secured” box. The
committee may also add a description of the loan in the
“Description” field.

If the loan is from the candidate’s personal funds, check
the “Personal Funds” box.

If the loan is from the candidate and derived from a
bank or some other source that is NOT the candidate’s
personal funds, click Schedule C-1... and enter all
information that is applicable to the loan.

If the loan is received directly from a bank or lending
institution, click on “Schedule C-1...” and enter the
required information. Note: If the committee receives
the loan directly from a bank or lending institution,
the committee is required to file a paper copy of
Schedule C-1 with the signature of the
representative from the lending institution and the
treasurer’s signature, as well as a copy of the loan
agreement.

After completing this section, click OK.
If there are any guarantors, click Guarantors...

Manual
Tab 6
Loan Made or Guaranteed by the Candidat X|
Name
fl

Joe Smith for Congress - 1865 Maple Avenue... g

Computers PAC - 643 Magnolia Trail...

Credit Card Compary - 34836 Chemywood Street... _:.I
Date Amount Interest Rate{%]
I I 0.00 |
Doseh
Election Year of Election Due date
| =i I
[~ Secwed [T Forgiven Date  Schedule C1...
[T Memo | Guarantors...
[ Personal funds

Next enty... | [ ok | concel

x
Lending Institution Date [ncured
[Local Bank |s/23103
US Postmaster - .. . - Date due
Local Bank - 18593 Cheny Tree Circle... j W
Loan amount Interest’s APR
[50000.00 [000

[ Loan has been restructured ~ Orniginal date |

Cradit amount this draw Dutstanding balance if line of credit
[o.00 Jo.00

[~ Other parties are secondarily iable

(~ Traditional collateral pledged
Yalue Descaption
j0.00 |

- Future income pledged-
Pledge account Walye
| |0.00

Credit Card Comparny - 34836 Cherywood Street... ﬁl
John's Hardware - 943 Dogwood Lane.. Estoblshed on
Local Restaurant - 1812 Plum Tree Diive. L]

| Description |
Alemate basis for loan and repayment

|
Authorized By Title
| I

Davis, Sam - 746 White Oak Street. ..

™ Peifected interest

Johnson, Joseph - 3837 Weeping 'Willow Drive...
Jones, James - 3217 Oak Tree Court x

o]
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10. Click Add new... to enter guarantor information. Click Edit... if the guarantor has been added
previously. Click OK to return to the “Loans Made” screen.

x
| Guarantor I Amount | Addnew....
(e
|
OK |
Cancel |
‘ |2

11. After the loan information is entered, click OK to return to the “Summary Page” view. Schedule
A supporting Line 13 and Schedule C supporting Line 10 will now have amounts reflected on the
Summary Page and the corresponding schedules will be created on the report.

Loan Repayments Made:

1. Go to the “Loans/Debts” view. x|
2. Click the loan for which repayment is being made, right Name
click, and click Loan/Debt payments... |Z“‘“"_*;*’J°e R -
mith, Jane - I Street... -
Click Add New... Tttt - 384 Poplas Lane.. =
4. Enter the creditor’s name; if the creditor has already Dats &mourt
been entered, select that name. Type the date, amount, lovzsrms | 2500000 BegEel
and enter “Loan repayment” into the *“Description” Dezciption
fl e | d |Loan repayment
Election YearofElection [~ 1400
5. Click OK to return to the “Loan/Debt Payments” screen, [Primary ll207d _
then click OK to close that window. Schedule B Candidate/Campaign Comitiee
supporting Line 19(a) or 19(b) and Schedule C | :
supporting Line 10 will now have amounts reflected on doo Seth o Congess 1655 WaploAvere.. 1
the Summary Page and the corresponding schedules Stih.Joe _836 Eln Shieel_ =
will be created on the report. Labbyist/Fiegistiant Bundier L Pl e

Joe Smith for Congress - 1865 Maple Avenue...

Computers PAC - 649 Magnolia Trail...
Davis, Sam - 746 White Dak Street...

Category code

| =
Check No. Account |dentifier

| [

Ll
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Closing/Uploading/Amending
Closing a Report .
1. Go to the “Reports” view.
2. Right click on the report and click Close Report. A
3. Enter today’s date in the “Date closed” field and click OK. x|
(Note: a Filing ID is only required when filing amendments o
and should be left blank for new reports.) =

Validating and Uploading a Report

1. First, follow the directions above for closing a report. (Closed
reports should appear in pink/purple in the “Reports” view)

Type | _Coverage |_Blection Date | Closed on | Signed by
Apri 1S Quarterly 01/01/2009 - 03312009 Davis, Sam
ALSO:ddy 1SQuarterdy  04/01/2009 - 06/30/2009 ! : _Dawvis, Sam
F3L - July Monthly | Semi-Annual 0601 /2009 - 06/ 302009 -

October 15 Quarterly 07/01/2009 - 09/30/2009 Davis, Sam
48-howr notice (Form 6) - 10/01 /2009 Davis, Sam

IMPORTANT: Save the file before validating and uploading!

Click Validate in the “File” menu or click the Validate icon, which looks like a card with a check
mark, along the top of the program.

‘Eﬁ - ﬂ@g % AESILIE

EB8YU L0

4. The validation program will notify the user if there are serious errors that will prevent the report
from being accepted by the Commission. For more help with Validation Errors, please see page
31

Fecfile X|

6 This filing has errors that will cause it to be rejected by the electronic-filing server. Please correct these errors before filing.
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5. Note: A report that has errors will not be allowed to upload. A report with warnings will
upload, but be advised that warnings indicate some missing information that may be required. If
no errors are found or the user wishes to file the report with warnings, then click Upload from
the “File” menu, or click the Upload icon, which is located directly to the right of the Validate

icon.
6. Enter the password (see page 2), engs =
9-digit committee 1D number, Uk | Cofiut
and email address. You must 5= e
confirm the password and email (8 /C00258848 (e.g C12345678)
address by entering them a Fax| ~ lg2neeny _
second time or the report will not Pessyud] Corlim | )
up|0ad. e-mail 1 | Confim | (2.9 iohndoe@cmte.com)
e-mail 2 Confim [e.g janedoe@cmte.com)
7. Unless otherwise directed by the — '
1~ Filing Method

FEC’s Electronic Filing office or
an FEC analyst, leave TCP/IP as

& TCPAP C SSL € Diap € A C B " Other

the Filing Method and then click |_{hicklztietetseiel (M pot e eostved 16 e aneccs ]

OK. (Note: “This filing amends” This fing amends |

field should not be filled in for

new reports.) [0k | Cocel | Hep |

8. Save the committee file after the
report uploads.

Amending a Report

Creating an Amendment:
1. Go to the “Reports” view.
2. Right click the report to be amended and then click Amend.
3. Click OK on the “Report Information” box.

a. Note: reports originally filed on paper before the committee crossed the electronic filing
threshold cannot be amended electronically.

b. The report will now have an Al, A2, etc. in front of it. Al is for the first amendment, A2 is
for the second amendment, and so on. If the user has filed any reports with coverage dates
following the amendment, FECFile will automatically generate amendments for those
reports. For instance, if the April Quarterly report is amended in November, FECFile will
also generate amendments for the July Quarterly and October Quarterly reports.

c. Note: these reports will automatically be generated, but not automatically uploaded. Also,
these additional amendments need not be uploaded unless there is a change in any of the
dollar figures (most commonly: election cycle-to-date, cash-on-hand totals, or aggregate
totals). If there are any changes in the dollar figures for subsequent reports, please upload
those reports as well (see page 27).
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Modifying Transactions for the Amendment:
|

1. Locate the transaction to modify.

. . \__‘.?/ Are you sure you want to modify the selected Report?
2. Double click on the transaction.

3. Make the desired changes to the transaction and = |
click OK.

4. When prompted, click Yes to modify the selected
report.

Adding New Transactions for the Amendment:

As with a new report, go to the “Summary Page” view and double click on the appropriate line
for that transaction.

Deleting Transactions from an Amended Report:

1. Locate the transaction to delete. X
2. nght click on the transaction and click Delete. \-?/ Are you sure you wank ko delete the selected transaction?
3. When prompted, click Yes to delete the selected

transaction. e [ we ]

Filing an Amended Report:

1. An amended report is filed like a new report: Close
the report, and then choose Upload from the File menu.

2. If the original report was created using FECFile, the x|
software will automatically fill out the “Filing ID” field.

Date closed
[1/15/06

Filing ID [Original]
FEC-123456

a. Do not alter this number unless instructed by an
FEC analyst or the FEC’s Electronic Filing

Office. [TI

b. If instructed to alter the number, or if the number
does not appear in the box, the filing ID is
located on the FEC’s Electronic Reports
Retrieval website. Type in the committee’s ID
number and click Send Query to find your
committee’s electronic filings.

http://www.fec.gov/finance/disclosure/efile_search.shtml
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Secrets to FECFile

Common E-Filing Mistakes!

Passwords
e Remember to obtain a password as soon as possible.

e Don’t wait until the last minute to apply for a password or to apply for a new one if necessary.

e Remember the committee’s password and keep it secure: the FEC cannot look up misplaced or
forgotten passwords; the Treasurer must request a new one.

Filing at the last minute

e Any problem, whether it’s technical or non-familiarity with the software, can be difficult to deal
with during the rush of a deadline week. It is advisable to always file as early as possible, especially
the first time the committee files electronically.

Email receipts confirm filing has been received.

e After uploading the report electronically, a receipt will be sent to the email address or fax entered
when uploading the report. Assume that the report was not successfully filed if no receipt is
received. Call the Electronic Filing Office (202-694-1642, Option #3) if more than a few minutes
pass without receiving a receipt.

e The receipt is proof of filing. Print it out and keep it.
Save and validate data set early and often

e Doing this through the process of report creation will ensure proper and consistent data entry as well
as preventing the loss of work due to unforeseen computer problems, i.e. freezes, crashes etc.

Back up the data file!
e The file that contains all of the committee’s reports, the “Data File” (*.dcf), should be backed up to
an external source.

e Itis very difficult and time consuming to recreate the committee file if it is lost.
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Common Validation Errors and How to Fix Them

Warning vs. Error Messages
There are two different types of validation errors: warning messages and error messages.
Warning messages:

These messages are a result of possible incorrect/missing information in the report so the user can
correct the issues (if necessary) before uploading the report. However, they do not prevent the
committee from uploading a report.

Error messages:

These messages result from more serious problems with the report and prevent the user from uploading
the report until the errors are corrected.

Reading and Understanding a Validation Message

Each warning or error message contains basic information that allows the user to pinpoint which
transaction is causing the issue. It also gives a brief description of the error. For example:

Form{ltem}: SA11Al {Johnson, Jane}
Field Name: #012 Employer
Warning  Conditionally Required Field is Empty

The Form {lItem} field identifies where the transaction causing the error is on the report. In the
example above, the transaction is on Schedule A, Line 11(a)(i) and is specifically identified as “Johnson,
Jane.” Field Name identifies the aspect of the transaction — in this case the employer field — that is
causing the problem. The last line identifies what type of message this is (Warning) and describes what
caused the problem (Required field is Empty).

In order to correct this problem, the user should find the specific transaction and edit it to disclose Jane
Johnson’s employer.

The FEC’s website includes a more extensive list of commonly found warning and error messages along
with brief descriptions and solutions.

http://www.fec.gov/support/fag valid.shtml
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Common Error Messages

Below are a list of common error messages that committees encounter and the steps that need to be
taken in order to correct the errors. Please remember that all error messages must be corrected before
you can upload your report.

Filing must be in the current FEC format

This indicates that you are using an outdated version of FECFile.

FECFile users will need to download the latest version of the software from the FEC's website
(http://www.fec.gov/elecfil/updatelist.html).

Amended filing must have an ID of the "Original*’

This indicates that the user is trying to submit an amendment absent the original report ID
number. The original report ID number must be used. If you are properly amending existing
reports in the committee file, the original filing ID should appear automatically.

If the user cannot locate his receipt for the original report, the ID number can be located on the
FEC's Electronic Filing Report Retrieval website (see below)
(http://www.fec.gov/finance/disclosure/efile_search.shtml).

View Download FEC-395205 Form F3A - period 10/01/2008-10/15/2008, filed 01/13/2009 - PRE-GENERAL
View Download FEC-395173 Form F3A - period 07/01/2008-09/30/2008, filed 01/13/2009 - OCT QUARTERLY
View Download FEC-390718 Form F3N - period 10/16/2008-11/30/2008, filed 12/04/2008 - POST-GENERAL

Once you have located the original filing ID (F3N), you will B
need to open, and then re-close your report so you can enter Dateclosed ¢ Fiing ID [Drigna™
the filing ID (see right). [1710/06 FEC-191664
NOTE: If this original report ID number is entered incorrectly, ok |

system errors will occur on upload.

Amended filing must have an
"Amendment Number**

BY

This means that either the
amendment indicator is missing
or incorrect. The  first
amendment will be Al, and et |[Ce=r ]
each subsequent amendment
will be numbered in sequence.

1 E You have not uploaded the report that is being amended. Would you like to continue?
L4

This error most likely occurred
because you did not properly
create an amendment or amended a report before it was filed.
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e Don’t amend a report that you have_ not uploaded. FECFile zj“:ﬁ e
will warn you with this message — click Cancel. Delete Del
e In the “Reports” view, right click on the report you are trying _
to file. If the report is closed, unclose it. Right click again Loan/Debt payments
and click Unamend. Memo Text...

Redesignate/Reattribute... »
e Repeat this process until your report is at the correct

numbered amendment %e ort...

Ckrl4r

Itemization »

Validation terminated! — Over 32,000 problems found!

e This indicates that 32,000+ errors have been found. The threshold for total errors for the system
is 32,000; therefore, the first 32,000 errors will be listed in accordance with their severity.

e If you receive this message please contact your reports analyst or the FEC electronic filing
office.

ID# NOT correct FEC ID# format
e This indicates that the committee ID
X ) Name |
number used is not in the correct format. 'i
e To correct this error, you will need to edit ikr[r”'r Political Action Committee - FILER o ———
your committee’s information. To do Voter Drive _ =
this, go to the  “Individuals/ Bierjorhn Iyee

Organizations” view and locate your FedEx-Kinkos | Political Action Commitiee

H H HERSETH, STEPHANIE . .
committee. Double-click on your R DG = 3. C12345676)
committee entry (it should be in red). Johnson, Jane Lookup...|
Make sure the committee ID number is A

correct. It might help to use the FEC
Lookup feature.

e NOTE: (correct example: C00123456) -
The “C” must be capitalized.

{Field} exceeds maximum length of

e This indicates the user has exceeds the maximum number of characters allowed in a particular
field

e This should not be a problem in FECFile because it will automatically limit the number of
characters you can input
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{Field) is required, but field is empty
e This indicates that information is required to be entered in a particular field, but has not been.

e Locate the transaction and fill in the field.

Extraneous data follows last field
e This usually indicates a technical problem, generally involving invalid characters.
e You should call the Electronic Filing Office if you receive this error (202-694-1307).

e NOTE: Only characters between ASCII 22 and ASCII 126 are acceptable. The ASCII 32 - 126
used to be the only characters allowed; however, the foreign language alphabet and punctuation
characters are also allowed. Specifically ASCII characters: 32 - 168 are allowed (excluding 127
and the series 157 through 159). Also, 173 is allowed.

Invalid double-quote surround text field — OR - Embedded double-quotes (**) not allowed
e This indicates that there are a set quotes around a text field where there should not be.
e Locate the transaction/field and take out the quotes.

e NOTE: Quotes are used as part of the data delimiter. Since the introduction of a level-8
message that says "Embedded double-quotes (") not allowed", this message only applies to the
very last field of a CSV string and only in the instance where a begin-quoted text is not
terminated with an end-quote. (Example: falling within the maximum length of that last field.)

e ADDITIONAL NOTE: Any field can have begin/end quotes (they are necessary for text that has
embedded commas). However, any field that has surrounding quotes may not also contain
double quotes anywhere within the text. Validator is only trapping "embedded quotes™ within
"text fields" which have surrounding begin-quotes and end-quotes. For example [,""",] is a case
of an embedded double-quote, but [,",] is not.

Body of text exceeds maximum of 20,000 characters (F99 filings)
e F99 (Miscellaneous text document) filings are limited to 20,000 characters in length.

e To correct this, either shorten your Form 99 filing or file more than one.

Leading blanks {e.g. "* TEXT""} not allowed
e This indicates that there are blanks prior to data; this is not allowed.
e Locate the transaction/field and delete the spaces that precede the first word in the file.

Bad date — not YYYYMMDD format
e This indicates the user has entered a date in the incorrect format.
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Locate the transaction and re-enter the date trying this format: MM/DD/YYYY.
is not a real date
This indicates that the user has entered an invalid date.
Locate the transaction and enter a valid date.
Invalid amount format: — OR — Non-numeric data
in numeric field
Fechile NN x|

This indicates that the user has entered values other than
numbers and decimals. t} Please enter a number.
.

Locate the transaction and enter only numbers and one

decimal point. FECFile will issue a warning before this error

is made. (See right)

NOTE: Dollar signs and commas are not permitted.

is an invalid year (CCYY) format

This indicates the user has entered the year in the incorrect format.

Locate the transaction and make sure the year referenced in the date field is in a four-digit
format.

District """ is not 2-digit numeric format

This indicates the user failed to enter the congressional district as two digits.

Locate the transaction, and make sure the congressional district field has two digits (ex: 04, 11).
Using the FEC Lookup feature might make things easier.
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